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Command Line Search in Connexion 
Open a web browser and go to http://connexion.oclc.org/.  Enter your 

Authorization number and password and select logon.  Then choose one of 

three command line searches to find what you need: 

 

l4:your OCLC symbol (Lowercase “L”) returns a list of all of your Local 

Holdings Records 

 

in:ISSN number if you have the specific ISSN.  Can enter with or without 

dash 

 

no:OCLC number  if you have the OCLC#.  Do not need to enter the ocm,  

ocn, etc. prefix. 

 

Once you find the record you want to add your local holding, either select from 

the Action Menu  Create Local Holdings or select from the View Menu  

Display Local Holdings.  Then select the gray button Display Local Holdings and 

follow the directions in Derive Local Holdings on page 11.  Choose to Derive 

Local Holdings only if you feel very comfortable using Connexion. 

 
 

  

http://connexion.oclc.org/
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Create Local Holdings 
Summary: Type in your summary information.  For example:  Retains current 

issue + 1 year. 
Leader: 

Click + box 

Record Status  

[05] c - 

Corrected or 
revised  

n – New (set by system) 

Type of record  
[06] y – 

Serial item 
 

(should already 

be set) 

Encoding level 
[17] 3 – Level 
3 

4 – Level 4 
(select 3 or 

higher) 

Item 

information in 
record  

[18] 
n – No item 

information 

(leave as is unless 

you are adding 

item information 

Apply 
 

007 

Click + box 

Category of 
Resource 

[00] t – Text 
c – Electronic 
resource 

(select t unless 

you are adding 

digital) 

Specific 

Material 

Designation 

[01] a – 
Regular print 

 

(select a.  If an 

electronic 

resource, select r 

– remote) 

Apply 
 

008 

Click + box 

This field has no indicators or subfield codes; the data elements are positionally 

defined. 

Character Positions 
00-05 Date entered on file (set by system) 
06 Receipt or acquisition status  

0 Unknown 
1 Other receipt or 

acquisition status 

2 Received and 

complete or ceased 

3 On order 4 Currently received 
5 Not currently 

received  

07 Method of acquisition  

c Cooperative or 

consortial purchase 
d Deposit e Exchange 

f Free g Gift l Legal deposit 

m Membership 
n Non-library 
purchase 

p Purchase 
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q Lease u Unknown 
z Other method of 

acquisition 

08-11 Expected acquisition end date  

<yymm> Date of cancellation or last expected part 

uuuu Intent to cancel; effective date not known 

No intent to cancel or not applicable 

12 General retention policy  

0 Unknown 
1 Other general 

retention policy 

2 Retained except as 

replaced by Updates 

3 Sample issue 
retained 

4 Retained until replaced by Microform 
 

5 Retained until replaced by cumulation, 
replacement volume, or revision 

6 Retained for a 
limited period 

7 Not retained 
8 Permanently retained 

 

13-15 Specific retention policy  

No specific retention policy  

13 Qualifier type   

l Latest p Previous  

14 Number of units 1-9 Number of units 1 

15 Unit type   

Time: m Month(s) w Week(s) 

 y Year(s)  

Part: e Edition(s) i Issue(s) 

 s Supplement(s)  
   

16 Completeness 
(Select 0 Other because you have no idea if they 

are all there once you are done) 
0 Other 1 Complete 2 Incomplete 

3 Scattered 4 Not applicable  
17-19 Number of copies reported (set by system) 
20 Lending policy (Decision time)  

a Will lend b Will not lend 
c Will lend hard 

copy only 

l Limited lending 

policy 
u Unknown  

21 Reproduction policy (Decision time) 
a Will reproduce b Will not reproduce u Unknown 

22-24 Language  (set by system) 
Blanks und Undetermined  

25 Separate copy report (set by system) 
0 Separate copy report  

26-31 Date of report  (set by system) 

Apply 
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852 

Click + box 
First Indicator Shelving scheme 
(Choose “No information provided” if you are not going to enter the shelving scheme) 

No information provided 

0 Library of Congress classification 

1 Dewey Decimal classification 

2 National Library of Medicine 

3 Superintendent of Documents classification 

4 Shelving control number 

5 Title 

6 Shelved separately 

7 Source specified in subfield ‡2 

8 Other scheme 

Second Indicator Shelving order 

(Choose “No information provided”) 
No information provided  0 Not enumeration 

1 Primary enumeration 2 Alternative enumeration 

Subfield Codes  

‡a Location (NR) 

(set by system will be your OCLC symbol) 
‡b Sublocation or collection (NR) 

(set by system will be your mail location - You can edit this if you wish) 

(If “No information provided” was NOT selected.  Beside the ‡b Sublocation 

field, click the Action down arrow  Add below Choose a subfield to add:) 

‡c Shelving location (NR) 
‡d Former shelving location 

(R) 

‡e Address (R) 
‡f Coded location qualifier 

(R) 

 

01 Qualifier type 

02 Number of units 

03 Unit type 

‡g Non-coded location 

qualifier (R) 
‡h Classification part (NR) 

‡i Item part (R) 
‡j Shelving control number 

(NR) 

‡k Call number prefix (R) (type in first part of call number) 

‡l Shelving form of title (NR) (type in the title) 

‡m Call number suffix (R) (type in Second part of call number) 
‡n Country code (NR) ‡p Piece designation (NR) 

‡q Piece physical condition 

(NR) 

‡s Copyright article-fee code 

(R) 

‡t Copy number (NR) 
‡u Uniform Resource Identifier 

(R) 

‡x Nonpublic note (R) ‡z Public note (R) 

‡2 Source of classification or 

shelving scheme (NR) 
‡3 Materials specified (NR) 

Apply 
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Must have 853/863 Pair or use 866 alone 
853 

Click + box 
First Indicator Compressibility and expandability   

0 Cannot compress or expand 1 Can compress but not expand 

2 Can compress or expand   3 Unknown 

Second Indicator Caption evaluation 

Indicator value not set 

0 - verified; all levels present   

1 - verified; all levels may not be present 

2 - unverified; all levels present   

3 - unverified; all levels may not be present 

 

Subfield Codes *Only the highest level of enumeration and chronology 

(volumes and/or years) is needed. 
‡a-‡h Enumeration captions 
‡a First level of 
enumeration (NR) 

v 

‡b Second level of 

enumeration (NR) 
i Action  delete     OR 

‡c Third level of 

enumeration (NR) 
no Action  add below 

‡d Fourth level of 

enumeration (NR) 
pt 

‡g Alternative numbering scheme, first level of enumeration 

(NR) 
‡h Alternative numbering scheme, second level of enumeration 

(NR) 
‡i-‡m Chronology captions 
‡i First level of 

chronology (NR) 
(year) 

‡j Second level of 

chronology (NR) 
(month) (season) Action  delete     OR 

‡k Third level of 

chronology (NR) 
(day) Action  add below 

‡l Fourth level of chronology (NR) 

‡m Alternative numbering scheme, chronology (NR) 

‡n Pattern note (NR) 
‡o Type of unit (R) 

‡p Number of pieces per issuance (NR) 
‡u Bibliographic units per next higher level (R) 

‡v Numbering continuity (R) 
‡w Frequency (NR) 

‡x Calendar change (NR) 
‡y Regularity pattern (R) 

‡z Numbering scheme (R) 
‡2 Source of caption abbreviation (R) 

‡3 Materials specified (NR) 

‡8 Field link and sequence number (R)  (You will most often enter 1)  

*See Notes 
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*Notes ‡8 - Field link and sequence number 

Subfield ‡8 contains data that identifies linked holdings data fields and may also 

propose a sequence for the linked fields. Subfield ‡8 is required in 853 fields in 

OCLC local holdings records. 

The structure and syntax for subfield ‡8 in the 853 field is: ‡8<linking number> 

The linking number is the only data element used in subfield ‡8 in the 853 field. It 

is a variable-length whole number that occurs in subfield ‡8 in all 863 fields that 

are to be linked to the 853 field. Fields with the same linking number are 

considered linked. A linking number of "0" (zero) is not used in this field. 

Subfield ‡8 is always the first subfield in the 853 field. 

Apply 
 

*If you have 853, you must have 863 
863 

Click + box 
First Indicator Field encoding 
level 

(Select the same as the Encoding 

Level from the Leader) 
No information provided 3 Holdings level 3 

4 Holdings level 4 5 Holdings level 4 with piece 
designation 

Second Indicator Form of holdings 

No information provided 0 Compressed 

1 Uncompressed 2 Compressed, use textual 
display 

3 Uncompressed, use textual 

display 

4 Item(s) not published 

 

Subfield Codes *Only the highest level of enumeration and chronology 

(volumes and/or years) is needed. 
‡a-‡h Enumeration captions  
‡a First level of 
enumeration (NR) 

Enter the actual volume 

number from item if 

available 

 

‡b Second level of 
enumeration (NR) 

Enter the actual issue 

number from item if 

available 

Action  delete     OR 

‡c Third level of 

enumeration (NR) 
Enter the actual number 

from item if available 
Action  add below 

‡d Fourth level of 
enumeration (NR) 

Enter the actual part 

number from item if 

available 

 

‡g Alternative 
numbering scheme, 

first level of 
enumeration (NR) 
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‡h Alternative 

numbering scheme, 
second level of 

enumeration (NR) 

  

‡i-‡m Chronology 

captions 
‡i First level of 

chronology (NR) 

Enter the actual 4-digit 

year from item if 

available 

 

‡j Second level of 

chronology (NR) 
Enter the actual month 

or season from item if 

available 

Action  delete     OR 

‡k Third level of 

chronology (NR) 
Enter the actual 2-digit 

date from item if 

available 

Action  add below 

‡l Fourth level of 

chronology (NR) 
  

‡m Alternative 

numbering scheme, 
chronology (NR) 

  

‡n Converted Gregorian year (NR) 
‡o Title of unit (R) 

‡p Piece designation (NR) 
‡q Piece physical condition (NR) 

‡s Copyright article-fee code (R) 
‡w Break indicator (NR) 

‡x Nonpublic note (R) 
‡z Public note (R) 

‡8 Field link and sequence number (R)  (You will most often enter 1.1)  

*See Notes 

 

*Notes ‡8 - Field link and sequence number 

Subfield ‡8 contains data that identifies linked holdings data fields and may also 

propose a sequence for the linked fields. Subfield *Notes ‡8 is required in 863 

fields in OCLC local holdings records. 

The structure and syntax for subfield ‡8 in the 863 field is: ‡8<linking 

number>.<sequence number> 

The linking number is the first data element used in subfield ‡8 in the 863 field. It is 

a variable-length whole number that occurs in subfield ‡8 in all 863 fields that 

are to be linked to an 853 field. Fields with the same linking number are 

considered linked. A linking number of "0" (zero) is not used in this field. 

The sequence number is separated from the linking number by a period "." and is 

required in 863 fields in OCLC local holdings records. It is a variable-length whole 

number that may be used to indicate the relative order for display of the linked 

fields (lower sequence numbers displaying before higher ones). 

Subfield ‡8 is always the first subfield in the 863 field. 

Apply 
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Or you can 866 with 853/863 pair or instead of 853/863 
866 

Click + box 
First Indicator Field encoding 
level 

(Select the same as the Encoding 

Level from the Leader) 
No information provided  3 Holdings level 3 

4 Holdings level 4 5 Holdings level 4 with piece 
designation 

Second Indicator Type of 
notation 

(Select 1 ANSI/NISO Z39.71 or ISO 

10324)  
0 Non-standard 1 ANSI/NISO Z39.71 or ISO 

10324 

2 ANSI Z39.42 7 Source specified in subfield 

‡2 

 

Subfield Codes 

‡a Textual holdings (NR)  (Copy text from Summary statement) 
‡x Nonpublic note (R)  ‡z Public note (R) 

‡2 Source of notation (NR) 

‡8 Field link and sequence number (R) (If used alone, enter 0.  If 

used along with 853/863 pairs, see notes below) 

Apply 

 

*Notes ‡8 - Field link and sequence number 

Subfield ‡8 contains data that identifies linked holdings data fields and may also 

propose a sequence for the linked fields. Subfield ‡8 is required in 866 fields in 

OCLC local holdings records. 

The structure and syntax for subfield ‡8 in the 866 field is: ‡8<linking number> 

Subfield ‡8 in 866 Textual Holdings fields have only the linking portion of the link 

and sequence number. Depending on the linking number used, they indicate 

the following: 

• Linking number 0: Holdings are recorded only in 866 Textual Holdings field(s). 

No 853 Captions and Pattern and 863 Enumeration and Chronology fields occur 

in the holdings record. 

• Linking number 0: Holdings data are recorded in the linked 853 Captions and 

Pattern/863 Enumeration and Chronology fields but the display form of the 

holdings is recorded in a single Textual Holdings field. The 866 Textual Holdings 

field replaces all of the 853/863 fields for display purposes. 

• Linking number is the same as the linking number in the linked 853 and 863 

fields: Textual Holdings replace the display of coded holdings with the same 

linking number. The content of a single Textual Holdings field will display in place 

of the Enumeration and Chronology fields linked to a Captions and Pattern field. 

• Unique linking number: Sequences the display of textual holdings data with 

the enumeration and chronology of the 863 fields. 
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When multiple 866 Textual Holdings fields are used in a record that has no 

853/863 holdings fields, all linking numbers in subfield ‡8 must be "0". 

 

Select the Edit Menu  Validate Record.  Make corrections if needed.  The 

systems will tell you what is wrong with lots of red marks.  If everything is ok, you 

will get a green Record Validated message.  Select the Action Menu  Add 

Record.  A popup window will ask if you really want to add this record, you 

select OK, because why would you have done all that work if you didn’t want to 

add it.  You will then be rewarded with another green message reading Record 

Added.  Rinse and repeat with your next record in the list. 
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Derive Local Holdings 
Browse through the list of Local Holdings.  Select a Local Holding Record from an 

organization on the list that you know has good records.  You also want to select 

one that is close to your own holdings statement.  Select the holdings statement 

to open the Local Holdings Record you would like to derive your record from.  

When their Local Holdings Record opens, you can select the Edit Menu  Derive 

New Record.  BUT…  Not all of the fields could be present (adding fields).  There 

could be extra fields that need deleting.  My advice is to create your own Local 

Holdings Records. 

 

 

Edit Local Holdings 
Locate the Local Holding Record requiring edits.  Expand field by clicking + box 

and add or delete subfields.  Be sure to apply changes in each field.  Select the 

Edit Menu  Validate Record.  Make corrections if needed.  The systems will tell 

you what is wrong with lots of red marks.  If everything is ok, you will get a green 

Record Validated message.  If you realize you have made a mistake and do not 

wish to edit the record, select the Edit Menu  Unedit record.  A popup window 

will ask if you really want to unedit this record, you select OK.  A green message 

will appear reading Record unedited.  You are ok to exit out of the record. 

When finished making edits, select the Action Manu  Replace Record. You will 

then be rewarded with another green message reading Record Replaced. 

 

 

Delete Local Holdings 
Locate the Local Holding Record requiring deletion.  Select the Action Manu  

Delete Record.  A popup window will ask if you really want to delete this record, 

you select OK.  Then a red message will appear reading “This was your last LHR 

for Master Record #####.  Would you like to remove your symbol (and any 

attached IRs) from this record?  Yes or No?  Select YES.  A green message 

appears reading Holdings Deleted.  Go back and double check your full LHR list 

to make sure it has been removed. 
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Example of Level 3 with 853/863 Pair  
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Example of Level 3 with 853/863 Pair and with 866 
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Example of Level 3 with Only 866 
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Resources 

OCLC glossary 

Find a comprehensive listing of OCLC terms accompanied by definitions. 

https://help.oclc.org/Librarian_Toolbox/OCLC_glossaries/OCLC_glossary 

 

OCLC-MARC local holdings format tag chart 

Find brief, general information on each tag and subfield available in local 

holdings records. 

https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_

MARC_local_holdings_format_tag_chart 

 

Local Holdings Maintenance 

You can use the Local Holdings Maintenance service to maintain accurate, 

current holdings information and to create Local Holdings Records (LHRs) that 

enable you to share detailed holdings information with library staff, users, and 

other libraries. By providing your library's detailed holdings information for 

materials in any format, including serials, the service supports resource sharing, 

collection development, circulation and acquisitions activities. 

https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance 

Create and maintain local holdings records 

Discover how to create, edit, and delete local holdings records. 

https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/Create_

and_maintain_local_holdings_records 

Quick references 

Discover how to order the Local Holdings Offline Product, download it, and 

import it into Excel as well as how to maintain local holdings information via 

Connexion browser. 

https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/Quick_r

eferences 

OCLC-MARC local holdings format and standards 

A detailed reference on the format for OCLC local holdings records. Defines 

fields, subfields, and indicators. Provides guidelines for creating and editing 

record content. 

https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_

MARC_local_holdings_format_and_standards 

 

  

https://help.oclc.org/Librarian_Toolbox/OCLC_glossaries/OCLC_glossary
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_MARC_local_holdings_format_tag_chart
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_MARC_local_holdings_format_tag_chart
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/Create_and_maintain_local_holdings_records
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/Create_and_maintain_local_holdings_records
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/Quick_references
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/Quick_references
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_MARC_local_holdings_format_and_standards
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_MARC_local_holdings_format_and_standards
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The GOLD Manual – Draft 

Resource Sharing, Compliance and Membership 

https://www.georgialibraries.org/gold_files/GOLD%20manual%202015%20draft.p

df 

 

Punctuation for Holdings Statements 

- Hyphen  

indicates an unbroken range of 

holdings, or a full range of holdings 

from a specified year or volume to 

date  

(eg, v1- 1963- )  

, Comma  
Used to show a gap or break in a 

range of holdings  

(eg, v1-v3,v5-) 

(1963-1965,1972-)  

; Semicolon  

Indicates a non-gap break when a 

numbering change occurs (may 

indicate a new series)  

(eg, v1-v2; no15- )  

: Colon  
Used to separate the first and 

second levels of enumeration  

(eg, ser1:v1- )  

/ Slash  

A connector between notations 

that forms a single entity, as two 

years that form a single period of 

coverage or a double volume  

(eg, v1/2 or 

1965/1966)  

? Question mark  

Shows an unknown quantity in a 

date Use mark only as the last digit 

May not be added to a date to 

qualify it  

(eg, 198? not 

1981?)  

From p. 17 https://www.georgialibraries.org/gold_files/GOLD%20manual%202015%20draft.pdf 

 
 

 

Chronology 
Months and seasons may be expressed either in natural language or by the 

following codes: 

Month Season 

01-12 - Month 21 - spring 

  22 - summer 

  23 - autumn 

  24 - winter 

A month code of less than two digits is right justified and the unused position 

contains a zero. 

 

Days of the month are recorded as two digits in the format 01-31. 

 

https://www.georgialibraries.org/gold_files/GOLD%20manual%202015%20draft.pdf
https://www.georgialibraries.org/gold_files/GOLD%20manual%202015%20draft.pdf
https://www.georgialibraries.org/gold_files/GOLD%20manual%202015%20draft.pdf
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When an alternative chronology scheme is applicable to an item, subfield ‡m 

contains the alternative chronology. If more than one level of alternative 

chronology is required, an 866 Textual Holdings field is used. 

 

When only chronology is used on an item (that is, the item carries no 

enumeration), the chronology is contained in the relevant enumeration subfield 

(‡a-‡h) instead of the chronology subfields (‡i-‡m). 
From: 

https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_MARC_local_holdings_form

at_and_standards/8xx_fields/863_Enumeration_and_Chronology-Basic_Bibliographic_Unit 

 

https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_MARC_local_holdings_format_and_standards/8xx_fields/863_Enumeration_and_Chronology-Basic_Bibliographic_Unit
https://help.oclc.org/Metadata_Services/Local_Holdings_Maintenance/OCLC_MARC_local_holdings_format_and_standards/8xx_fields/863_Enumeration_and_Chronology-Basic_Bibliographic_Unit

